Bridge Image Management

By Martin Evening

One of the consequences of working with digital images in Photoshop
is you will soon find yourself struggling to cope with an ever-growing
collection of images. To address this, you'll want something more
than the system folder browser to preview and access all the files that
are stored on your computer system. At a minimum you need some
kind of file browser that allows you to preview images easily, choose
which ones you want to open in Photoshop and carry out basic file
management tasks such as rating images and adding metadata.

For some time now Adobe have simply Bridge maintained as a
Suite-wide browser without adding new features. With this latest
release however, new work has been done to give the program a
complete overhaul and a new interface.



The Bridge solution

Bridge is included with Photoshop, as well as being part of the Creative
Suite package. Bridge is best described as a dedicated file browser
program, which also works smoothly with Adobe Camera Raw,
allowing you to open your raw image files (assuming your camera’s
raw format is supported) and manage the Camera Raw settings. The
Bridge integrates nicely with all the programs in the Adobe Creative
Cloud, as well as many other programs. It also contains most of the
tools you need to import and manage your images, plus Bridge allows
you to work directly with the automation tools in Photoshop, such

as Photomerge and the Image Processor. The interface offers easy
workspace switching, one-click full screen previews and the ability to
create Collections. Bridge may not be as fast as some other browser
and cataloging programs, and inputting metadata and keywords is an
awkward process, but I still find it very useful as a project managing
tool when working on things like this book.

Bridge alternatives

Operating systems may in future offer better image browsing tools and
on the PC platform it is interesting to note how the Windows operating
system contains a photo browser that offers improved image navigation
for photographs. If you are using the macOS operating system you can
use the Spacebar to quickly preview selected images, or use the Cover
Flow View folder navigation mode to visually inspect the contents of a
folder.

In the meantime, there are several dedicated File Browser programs
on the market that can help you manage your images better, such
as PhotoMechanic™. More recently, we have seen the emergence of
digital photography workflow programs such as Adobe Photoshop
Lightroom™, which is designed to provide a complete workflow
management solution from the digital raw processing stage through to
image library management and Print, Book and Web output.
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Configuring the General preferences

First, lets go to the Bridge preferences and look at the General settings
(Figure 1). The bridge preferences can be accessed via the Edit menu in
Windows or the Adobe Bridge CC menu in macOS.

In the Behavior section you can choose to make Adobe Photo
Downloader launch by default whenever a new camera card is inserted
(or if a camera is connected to the computer directly). The ‘Double-
Click Edits Camera Raw Settings in Bridge’ option allows you to
override the default behavior and forces Bridge to be the program that
always hosts the Camera Raw plug-in.

The ‘€3 (Mac), (PC)-click Opens the Loupe When
Previewing or Reviewing’ option applies to the Preview panel and
Review modes so that the loupe only shows when the (Mac),
(PC) key is held down.

Figure 1 The Bridge General preferences.
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The Bridge program maintains a list of the most recently visited
folders to enable fast and easy access. The default number is 10, but
you can increase this number if you want. The Favorite Items section
contains checkboxes that let you select which items you want to see
listed in the Favorites panel (see Figure 35 on page 29) and lastly,
the Reset button, which can be used to reset all the alert warning
dialogs in Bridge.

Most files can be opened via Bridge. Well, almost anything. You
can think of Bridge as being like an advanced file navigation dialog
for all the programs in the Adobe Creative Cloud, although you
are not just limited to opening Creative Cloud-created documents.
For example, you can also open things like Word files in the Word
program via Bridge, plus you can drag and drop documents from the
Bridge window to an external folder or vice versa.

Launching Bridge

The Bridge interface is shown in Figure 2. You can launch Bridge

by going to the File menu in Photoshop and choosing ‘Browse in
Bridge... Or, you can use the EIEI(@) (Mac), ZDEDE (PC),

or EIETDH@) (Mac), BIDEZEDBED (PC) shortcuts. Both these
commands can also be used when you wish to go from Bridge back
to Photoshop. To open an image from Bridge, simply double-click a
thumbnail or press the or key and the image will open
directly in Photoshop. If you want the Bridge window to close as you
open the image, then simply hold down the key as you double-
click. Now, if you refer to Camera Raw chapter in the book, you will
read how opening Camera Raw files will vary depending on how the
Camera Raw preferences had been configured, which I discuss in
the following paragraph. Essentially, when you double-click on a raw
image file thumbnail, or multiple thumbnails in Bridge, this normally
opens the raw images via the Adobe Camera Raw dialog hosted by
Photoshop, and if you go to the File menu in Bridge and choose
Open in Camera Raw... (EJGED [Mac], BDED [PC)) the images
will open via the Camera Raw dialog hosted by Bridge. The subtle
distinctions between which application hosts Adobe Camera Raw are
elaborated on further in the Camera Raw chapter. If you hold down
the key as you double-click, you can open a raw image via
Photoshop bypassing the Camera Raw dialog completely.
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Figure 2 The Bridge interface.
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You can also edit JPEG and TIFF images via Camera Raw, but be
warned that this added capability can also lead to confusion when
opening images. To explain in more detail, you can set the Camera Raw
preferences to determine how JPEG and TIFF images are handled.
Here, you can disable the ability to open JPEGs and TIFFs via Camera
Raw, you can enable automatic opening of all supported JPEGs and
TIFFs, or you can enable the automatic opening of only those JPEGs
or TIFFs that have previously been processed via Camera Raw. To
override these last two preferences, hold down the key as you
double-click to open the image. If Camera Raw settings have been
added to an image previously, these will be applied as you open. If there
are no Camera Raw settings associated with an image, it will open
directly in Photoshop as normal.

Rotating the thumbnails and preview

To adjust the way the thumbnails are displayed in the Content panel,
you can drag the Zoom slider at the bottom of the Bridge window or
use (Mac), (PC) to make the thumbnails bigger and
use EPE (Mac), @IE (PC) to make the thumbnails smaller. If you
click on the ‘Lock thumbnail grid view’ button (bottom of Figure 2), as
you resize the Content panel area the number of thumbnail columns
remains locked. You can apply 90° rotations to the thumbnails using
the Rotate commands in the Bridge Edit menu or use the following
keyboard shortcuts: (Mac), (PC) rotates thumbnails
anti-clockwise and (Mac), (PC) rotates them clockwise.
Alternatively, you can use the Rotate buttons in the top left section of
the Bridge window. Note that this doesn’t physically rotate the images
in Photoshop; the image rotation only takes place when you actually
open the image.

Adding new folders
New folders can be added by choosing New Folder from Bridge’s File

menu (EIEZDED [Mac], [PC]), or you can use

(Mac), or right mouse-click in the Content area and choose ‘New
Folder’ from the contextual menu.
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Figure 3 This shows an enlarged view of the Workspace settings list. Mouse down on
the disclosure button (circled) to reveal more workspace options.

Arranging the Bridge contents

You can customize the visibility and order of the various panels and
rearrange the Bridge layout to suit your own particular requirements.
For example, you can click on any of the Workspace settings buttons
shown in Figure 3 to quickly switch between the different pre-
configured Bridge workspaces. These include workspaces for different
kinds of Bridge tasks such as Filmstrip viewing or Metadata editing. Or,
you can create your own custom workspace layout. To do this, go to the
Window menu where you can highlight a panel item to toggle making
it either hidden or visible. Now drag the panel to a new position, or
create a new panel grouping arrangement in either of the three main
panel sections. The panel sizes can be adjusted in height by dragging
the horizontal panel dividers and you can double-click a Panel tab to
quickly collapse the panel contents to show the tab only and double-
clicking the Panel tab expands the panel contents to its former size
again. If you double-click on a panel divider (as shown on the next
page in Figure 5) you can collapse all the panels in that section, plus

if you hit the key, you can toggle collapsing or revealing both ez

the side panels. When you have finished adjusting the Bridge layout, o b
. . . G save Window Location as Part of Workspace (" Gancal )

you can save it as a new custom workspace setting. To do this, go to Pl Lo —

the Window menu and choose Workspace = New Workspace... This
opens the dialog shown in Figure 4, where you have the option to

include both the window location and sort order setting as part of the Figure 4 To create a new workspace
overall workspace setting. The saved workspace setting will then appear ~ Setting, go to the Window menu and
first in the Window = Workspace menu list. choose Workspace = New Workspace. ..

You can also make different workspace settings active by using
the (Mac), (PC) through to (Mac),
(PC) keyboard shortcuts (where (Mac), (PC) selects
the ‘Essentials’ workspace). Note though that when you create a new
workspace setting this shifts the keyboard shortcut assignment along one
in the order the shortcuts appear listed, so just be aware that the above
shortcuts will update each time you save a new workspace setting.

You can also rearrange the order of the thumbnails in the
Content panel by dragging them. This changes the sort order to ‘Sort
Manually” and the new sort order will remain sticky until such time as
you change it again.
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Figure 5 The panel arrangements in Bridge can be customized to suit your own
preferred way of working. If you double-click on a Panel tab, such as I have done here
with the Keywords panel (circled in blue), this collapses the panel to just a tab. The
panel sizes can also be adjusted by dragging on the vertical and horizontal dividers,
and if you double-click on the divider bar (circled in red) you can toggle showing and
hiding a side panel section. In this example, you can see how | expanded the Preview
panel to see a large preview of the current selected thumbnail.
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Customizing the panels and content area

Let’s now step back a bit and look more closely at how the Bridge
interface is structured. Essentially, the Bridge window interface
consists of three adjustable sections and these are used to contain

the individual Bridge panels, with a main Content panel that’s always
visible in the middle. The individual panels can be adjusted vertically
as well as horizontally and placed in any section of the Bridge interface.
Meanwhile, the Content panel has Thumbnails, Details and List
viewing modes, and you can switch between these by going to the View
menu, or by clicking on the buttons in the bottom right section of the
Bridge window. By combining different panel layouts with these three
Content panel viewing modes, it is possible to achieve a wide variety
of workspace layouts. In Figure 6 you can see a bare bones layout of
the Bridge interface, where only the Content panel is visible in the
middle. In Figure 7 I show a Bridge layout where the Content panel
area remains in the Thumbnails view mode and the Folders panel is
now visible on the left. In Figure 8, I added a Metadata panel to the left
panel section and switched the Content panel area view to the Details
view mode.

Figure 6 Here is a basic view of the three panel sections that make up the Bridge
interface, where just the Content panel is visible (you can’t hide the Content panel).
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Figure 7 You can make more panels visible by going to the Window menu in Bridge and
highlighting the ones you wish to add (those panels that are already visible will have a tick
mark next to them). Here, | made the Folders panel visible within the left panel section.

Figure 8 Here, | made the Metadata panel visible, adding it to the panel section on the left, plus
| switched the Content area to the Details mode by clicking on the ‘Details’ view button (circled).
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Bridge workspace examples

Let’s now look at just some of the available workspace settings. The
Light Table layout shown in Figure 9 is useful should you wish to
maximize the Content panel size and have it fill the screen.

The Libraries setting, shown in Figure 10 (3@ [Mac],
[PC]) is ideal for editing large photos as it uses a large preview
panel size with a Horizontal filmstrip running along the bottom of
the window and you can use the left and right keyboard arrow keys
to navigate through the filmstrip thumbnails. These two workspaces
provide nice simplified Bridge layouts that are ideal for navigating
photographs. If you look closely, you will notice that the Content
panel has a fly-out menu for managing the Content thumbnail layout
(see sidebar). For example, you could create a vertical filmstrip layout
using a narrow Content panel in the middle section (set to vertical
scrolling) combined with a large Preview panel in the right column.

Figure 11 shows the Keywords layout (E3@) [Mac],
[PC]) where the focus is on the Keywords panel and the
Content panel is in Details mode, displaying the main essential image
data alongside each thumbnail.

[ XX 11 Venice 2019 - Adobe B

Figure 9 Here is a view of a Bridge window configured using the Light Table
workspace. Note the Content panel layout options (circled).

This PDF is provided free with the Adobe Photoshop for Photographers book. Not for distribution or resale.

Content panel scrolling

The Content panel has a small menu icon
in the top right corner (this is circled in
Figure 10), where if you mouse down, you
can select a Horizontal, Vertical or Auto
scrolling layout. You can use this menu to
force the thumbnails in the Content panel
to scroll vertically (which is the default
used for most of the workspace layouts) or
scroll horizontally (such as in the Filmstrip
workspace layout in Figure 10). If you select
Auto, Bridge automatically works out the
best direction to scroll the thumbnails in.

Horizontal Layout
Vertical Layout
' Auto Layout
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Figure 10 The Libraries workspace (E)(@ [Mac], [PC]) combines a large Preview
panel with a narrow Content panel that runs along the bottom using a scrolling layout.

Figure 11 The Keywords workspace (EEE [Mac], [PC]) displays the Content
panel in Details view mode with the Favorites, Keywords, Filter and Export panels on the left.
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Working with multiple windows

You can also have multiple Bridge window views open at once. This
allows you to view more than one folder of images at a time, without
having to use the Folders panel or window navigational buttons to
navigate back and forth between the different image folders. That’s
not all though, because multiple windows can also make it easier to
compare images side by side when reviewing a collection of images.

In the Figure 12 example below I pointed Bridge at a folder of
images using a modified Preview workspace layout, where single
images could be previewed large in the Preview panel and the Content
panel used to display a vertical filmstrip of thumbnails. I then chose
File = New Window to create a duplicate window view and dragged
this off to the right. I was then able to navigate through the image
thumbnails in the second window and compare alternative shots with
the one displayed in the first window.
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Figure 12 Using two Bridge windows to compare photographs side by side.
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Figure 13 The Bridge Slideshow view mode.

Slideshow mode

The Bridge window contents can be previewed in Slideshow mode by s
choosing View = Slideshow (E3(® [Mac], [PC)). Press @) to e -
call up the Slideshow commands menu shown here, where you'll notice " Blaok Out Addiionsl Moritors
you can use the €3 @ keys to zoom in and out during playback. The r_‘x::’::‘:m !
Bridge Slideshow feature is useful for showing on-screen presentations, —

 Side Options
but I think you will find that the Slideshow viewing mode also offers a e i
nice, clear interface with which you can edit your pictures; one that’s coion (o -]
devoid of all the clutter of the Bridge window interface. Figure 13 When Presenting, Show Slides ‘
shows the Bridge Slideshow in Full Screen mode, where you have o;f‘:"t:m ‘
access to all the usual image rating options. There is also a triple-click o ‘.
shortcut for zooming into the corners at 100%, but in practice it’s rather o nt
complicated to use. As you review edit a folder of photos, you can use Transifion | Dissove -
the keyboard arrow keys to progress through the shots and you i Ul i |
can use the apostrophe key (@) to toggle adding or removing a single (oo )

star rating, or use the (@ key to increase and the @ key to decrease
the overall star rating. To access the Slideshow settings (including the
slide transitions and zoom options) go to the View menu and choose Figure 14 Slideshow Options dialog.
Slideshow Options... (Figure 14)
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Thumbnail settings

If you go to the thumbnail quality options menu in the Bridge window
you can select a policy for the thumbnail generation (Figure 15). ‘Prefer
Embedded’ uses whatever previews it finds and makes the browsing

of non-cached images faster (you can also click on the button to the
left to switch to this mode). The ‘High Quality On Demand’ option
aims to rebuild accurate previews, but only when you actually click to
select a thumbnail. Lastly, the ‘Always High Quality’ option rebuilds the
thumbnails for all files it encounters that are not already stored in the
Bridge cache.

- Libraries  Filmstrip ~ Output  Metadata v Q v gallagher X
N >
4 v ) Yov | sortbyFiename |+ | wgv im W
 Prefer Embedded (Faster)
High Quality On Demand
Vv Always High Quality

Generate 100% Previews

v Show Transparency Grid

Figure 15 The Thumbnail quality options.

Thumbnail generation

To improve the responsiveness when browsing through large numbers
of assets, Adobe have made improvements to the way the thumbnails,
previews, and metadata are generated. When you select a folder, the
thumbnails, previews, and metadata are extracted on priority for
the on-screen assets only. The thumbnails for the remaining files are
either generated on demand (if the user scrolls down/up) or when the
application is idle. This means you can work with folders that have a
large number of images without any performance issues like hangs or
not responding states. This means you can have a fully updated Filter
panel even before all the thumbnails and previews have been generated.
This also means you can search for files even before all the thumbnails
and previews have been generated and improves the overall scrolling
experience.

Even so, it can take a long time for Bridge to generate thumbnails
and previews of large image files. If you have the Maximize PSD
and PSB File Compatibility preference turned on in the Photoshop
preferences, the layered PSD files will generate a composite image layer
when saved and this can certainly reduce the time it takes to build each
preview in Bridge. If you limit the file size for rendering previews using
‘Do not process file larger than: x MB’ this can also help speed up the
time it takes to build a preview cache for very large files.

This PDF is provided free with the Adobe Photoshop for Photographers book. Not for distribution or resale.

Thumbnail size and workspace

When you create a new workspace in

Bridge, it includes the thumbnail size as

part of the workspace setting. However,

if you adjust the thumbnail size after
creating a workspace, the thumbnail size

is automatically updated in the workspace.
In case you want to revert to the original
setting, use “reset” option for the workspace.
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Figure 16 The Bridge Thumbnails preferences.

Thumbnails preferences

The Bridge Thumbnails preferences are shown in Figure 16. Here
you can limit the thumbnail generation to files that are of a certain
size or lower (setting a lower limit can help speed up the thumbnail
generation). In the Details section you can have extra lines of
metadata appear beneath the thumbnails in the content area (as
shown in Figure 17). Here, up to four additional lines of metadata can
be added beneath the thumbnails in Bridge. To hide, use the
(Mac), (PC) keyboard shortcut to toggle hiding and showing
the text information that appears below the image thumbnails in the
content area.

The ‘Show Metadata on Hover’ option allows you to see the
additional lines of metadata as you hover the cursor over each
thumbnail, rather than check each item to have a persistent metadata
display as shown in Figure 17.
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Figure 17 Up to four additional lines
of metadata can be added beneath the
thumbnails in Bridge.
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Cache management

From the moment you open an image folder in Bridge, the program General = }
sets to work building the thumbnails and previews, reading in the o e g i S oy
image file metadata as it does so and taking into account things

like: Camera Raw edits, image rotation instructions, file ratings and
labeling. It speedily generates the low res thumbnails first before
running a second pass to build the higher resolution thumbnail
previews. This is quite a lot of information that Bridge has to process,
and if it is your intention to use Bridge to manage large collections
of images (especially large numbers of raw files), it will appear

Apply sharpening to:  All images

Figure 18 The Camera Raw General
preferences.

frustratingly slow unless you have a fast computer.

Therefore, the information that is built up during the cache ~LeALeLCR2 ~LBALGLXMD
building process is stored in the form of ‘cache data, which has two Figure 19 If the Camera Raw preferences
components: the image metadata and the preview cache. If a cache are set to save xmp files as sidecar files,
is present, the inspected folder displays the archived thumbnails, you will see sidecar files like this appear

previews and metadata almost instantaneously. This works fine so long alongside a raw image file that has been
as the folder is being inspected on the computer that created it and the modified via Bridge.

folder name has not changed since the cache was created. If these two

conditions are not met, then Bridge has to start all over again and build

a fresh cache for that folder. Also, if a folder contains a cache that was

exported from Bridge CS6 or earlier, Bridge will be able to read it, but

earlier versions of Photoshop will not be able to interpret Bridge CS6 or

Bridge CC cache files.

With proprietary raw files the Camera Raw database is the only
place where the metadata information such as the image ratings and
Camera Raw adjustments can be kept (Username/Library/Preferences
folder [Mac], or Username\AppData\Adobe\CameraRaw folder [PC]).
That is, unless you go to the Camera Raw preferences (Figure 18) and
choose to save the image settings to the sidecar “xmp” files. When you
do this, the metadata information is also saved to the XMP sidecar
files that are stored alongside each raw image (Figure 19). Basically,
file-specific information that can generally be read by other programs,
such as the custom IPTC metadata and Camera Raw settings (Adobe
programs only), are normally stored in the file header XMP space.
However, because proprietary raw files are an unknown entity it is only
safe to store such data within the Camera Raw database or a separate
XMP sidecar file that travels with the raw file when it is moved from
one folder to another. The sidecar files are also automatically renamed
if the original master is renamed.

This PDF is provided free with the Adobe Photoshop for Photographers book. Not for distribution or resale.
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Cache preferences

The Bridge Cache preferences are shown in Figure 20. The central
Bridge cache stores thumbnail, preview, and metadata information in
a database. This cache database improves the performance when you
browse or search for files. However, the larger the cache, the more
disk space it uses. You can limit the cache size and restrict this to a
set number of files. As more files are cached, the older cache items get
deleted, so increasing the cache size limit means more cache data is
preserved, but at the expense of increased disk space usage.

Obviously, it helps to make the metadata and preview cache
information as accessible as possible. If the ‘Keep 100% Previews in
Cache’ option is selected, this potentially increases the size of the
cache, but you’ll have faster access to the full-sized previews. If you
select ‘Compact Cache on Exit, and the cache database size grows
beyond 20 MB, this pops a dialog when you exit Bridge asking if you
would like to compact the cache for more economical cache storage
(see Figure 21). This optimizes the Bridge cache files stored on your
computer, removing files that are now obsolete and thereby keep the
cache size under control.

Having generated cache files for each folder visited you will want
to enable ‘Automatically Import Cache from Folders when Possible’
so that Bridge is able to utilize previously generated cache files. Lastly,

Enabling backward compatibility

Itis a good idea to switch on the Maximize
the PSD and PSB compatibility option in
the Photoshop File Handling preferences.
This forces Photoshop to save a flattened
version of the image when saving a file
using the PSD and PSB formats. This in
turn can speed up the writing of the preview
cache file.

Figure 20 The Bridge Cache preferences.
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Bridge has identified that its cache needs to be compacted for optimal performance. It will be
unavailable during this period.

(@) ool he on exit as required. (R e

Remind Me Later | Compact and Exit

Figure 21 The Adobe Bridge Compact Cache dialog.

there is an option to purge cache files after a certain number of days
during idle periods. Seeing how the cache management has improved
so much with compact cache files, I feel this is less necessary now.

Cache Management preferences

The Bridge Cache Management preferences are shown in Figure 22.

Figure 22 The Bridge Cache management preferences.
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Every time you open a folder, Bridge checks to see if there is a cache
for that folder located in the Username/Library/Caches/Adobe/Bridge
CC/Cache folder (macOS), or Username\AppData\Roaming\Adobe\
Bridge CC\Cache (PC). Note you can change these destinations via
the Location section below. The Manage section offers further controls
to optimize the Bridge cache files stored on your computer. Click the
Compact Cache Now button to remove files that are now obsolete and
keep the cache size under control.

The Purge cache section can be used to clean up the stored cache
files for the currently selected folder. You can click on the ‘Purge All
Local Cache Files’ button to empty the cache for the local selected
folder while Bridge is open and idle.

Sometimes a cache may appear out of date and require a forced
update. To do this, go to the Tools = Cache menu and choose the
‘Manage Cache’ option (Figure 23). You can use this to force Bridge
to prioritize building a cache for not just the current targeted
folder, but all the subfolders as well. For example, you might find it
beneficial to get Bridge to cache large folders of images during idle
times, such as at the night, and optionally include building of 100%
previews. If you know that there is already a hidden cache stored, you
can click on the Import Cache button to import rather than have to
rebuild. The Clean Up Cache button options can be used to purge the
cache from specific folders.

Figure 23 The Manage Cache dialog.
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Media Cache preferences

The Media Cache preferences are shown in Figure 24. This refers to
video and audio files as opposed to still images. The Bridge cache
storage of media files can speed up playing them back. However, over
time the playback performance can suffer unless you keep the media
cache trimmed.

Figure 24 The Adobe Bridge Media Cache preferences.
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Advanced preferences

The Advanced Bridge preferences are shown in Figure 25. By default
Bridge uses hardware acceleration to drive the graphics display, but if
you are working with an underpowered graphics card you may find
it better to check ‘Use Software Rendering’ and relaunch Bridge. The
‘Generate Monitor-Size Previews’ option ensures the cached previews
are big enough to fill the screen, such as when using the Slideshow or
Review modes. Check the ‘Start Bridge at Login’ option to get Bridge to
launch automatically each time you start up the computer.

The International section can be used to regionalize Bridge for
international languages and for use with international keyboard
designs. The changes applied here will only come into effect after you
relaunch Bridge.

Figure 25 The Bridge Advanced preferences.
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Export preferences

The Export preferences are shown in Figure 26. The Export panel in
Bridge is a new addition. This allows you to convert assets such as
images, videos or PDFs to an image file format (Currently just JPEG
for now).

In the Bridge Export preferences Options section, you can set the
‘Maximum number of export jobs to keep in job list, plus limit the
‘Maximum number of job details in the job progress. The defaults allow
you to keep a maximum number of 100 export jobs listed. After that,
Bridge deletes the older history beyond 100 job details. The maximum
number of jobs you can queue up at one time is 20, but you can make
this lower if you wish.

Figure 26 The Bridge Export preferences.
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Interface preferences

The Interface preferences (Figure 27) contain the Appearance controls
where you’ll notice that the Color Theme options are the same as those
in the Photoshop preferences. This means you can easily match the
Bridge user interface to whatever theme you have selected in Photoshop.
You can also override this by adjusting the Image Backdrop slider to
apply your own desired interface brightness setting.

The text Size menu can be used to select from the four text font sizes.
With high resolution displays now becoming more common, you may
find a bigger text size more legible.

Figure 27 The Bridge Interface preferences.
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One-click previews

With Bridge you can click the Spacebar to quickly preview an image

at a full size on the display. Once in the full display preview mode, you
can click with the mouse to enlarge a photo to 100%, click to return to
the full screen view again and use the arrow keys to navigate to the next
or previous photo. To return to the Bridge window, click the Spacebar
again. When it comes to picture review editing, one-click editing offers
a speedy and more controllable alternative to the Slideshow view mode.
You can navigate easily from one photo to the next and add ratings or
labels as you edit. It's simple and effective.

Deleting files

You can use the key to delete selected files. This pops the dialog hdab Bridas
shown in Figure 28 that asks you to confirm deletion. Alternatively, ) T
you can mark an image as a Reject via the Label menu. Or, you can Do Tt o ol o Comnand + Ot et an

use the [Mac], [PC] shortcut to mark as a reject. - Domtsnowagan | Cacsl | [ b | (Rt )
This labels the file with the word ‘Reject’ in red. You can then use the \
Filter panel to select the ‘mark as rejected’ images only and delete
them as required. If you then click on the Delete button this pops the
dialog shown in Figure 28 asking you to confirm deletion. Likewise,
clicking the Delete button (i) in Bridge takes you straight to the ‘Are
you sure you want to move file to the Trash’ dialog as does
(Mac), (PC). Deleting via Bridge removes the thumbnail
from the Bridge window and sends the original file to the Trash (Mac)
or Recycle bin (PC). Even so, files won’t be permanently deleted until
you empty the contents of the Trash (Mac)/Recycle bin (PC) at the
operating system level. As a safety precaution, when deleting folders
via Bridge, you can only do so if they are empty.

Figure 28 The Delete file dialog.

Stacking images

You can use the Stack menu in Bridge to group files into stacks (see
Figure 29). In the screen shot steps shown on the following page you
can see an example of how selected files can be grouped in this way.

To use this feature, select two or more files, go to the Stack menu and
choose Group as Stack (EP(E) [Mac], [PC]). This groups the
images, indicating they are part of a stack with a number showing how

many files are included in the stack. To ungroup images from a stack, O Jedek
use: (Mac), (PC). To expand a stack use: JBSEAEf

(Mac), (PC) and to collapse a stack again use:
(Mac), (PC). If you want to expand all stacks use: Figure 29 This shows how the

(Mac), (PC) and if you want to collapse all stacks use: thumbnail for a stacked group of files will
(Mac), (PQ). appear in the content area.
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1 Here, six thumbnails were selected in the Content panel. To group these images into a
stack, | used the (Mac), (PC) shortcut.

2 Here, you can see how the stacked files were displayed in the Content panel area as an
expanded stack. For this step, | selected the most representative image and chose Stacks
= Promote to Top of Stack. This made the selected file the key image used to identify all
the images in the stack.

This PDF is provided free with the Adobe Photoshop for Photographers book. Not for distribution or resale.

Adobe Photoshop for Photographers: Image Management 26



Auto-stacking

You can use the Stacks = Auto-Stack Panorama/HDR command

(Figure 30) to auto-stack images. The way this works is that Bridge
scans the images in a selected folder and where it finds two or more
images that have been shot within an 18 second time frame, makes

these candidate photos for a panorama or Merge to HDR image set. Expand All Stacks -

. L. . . s Collapse All Stacks X3+~
Once it has done this, it further analyzes the images using Photoshop’s Frame Rate >
auto-align technology. If a sequence of images overlap by 80% or less,

these are logically assumed to be part of a panorama sequence. Where

a sequence of images overlap by 80% or more and the EXIF data shows  Figure 30 This shows the Stacks =
that the exposure values are changing by one or more stops, these are Auto-Stack Panorama/HDR command.

assumed to be part of a Merge to HDR pro set. Using this logic, Bridge
is then able to organize photos into stacks and at the same time create
and store metadata information that can be used later by Bridge to
auto-process the stacked images either as panoramas or as Merge to
HDR sets (Figure 31). The auto-stack feature generates a hidden XML
file that is added to the folder and this stores the ‘how-to-process’
information. The processing can then be done later by choosing

Tools = Photoshop = Process Collections in Photoshop (Figure 32).
In actual fact, you can carry this step out directly, without applying

an auto-stack first. When you apply this command, the images that
have been auto-collected into stacks are automatically processed in
Photoshop. Now, the plus side of this feature is that it may benefit large
volume panorama or HDR shooters (especially the ability to group
photos into stacks). On the downside, there is no interface that can be
used to modify, say, the time frame period from anything other than
18 seconds. There is also no interface that allows you to choose specific
options when generating the Photomerge composites. The reliability
with which auto-stack manages to successfully detect the images is
also rather hit and miss. When it works well it has the potential to

be a powerful tool, when it doesn’t, you’ll just have to redo the work
manually. Overall, it’s an interesting innovation that will hopefully be
improved upon in future Bridge updates.

This PDF is provided free with the Adobe Photoshop for Photographers book. Not for distribution or resale.
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Q! Bridge Search: Current...

Figure 31 Here, you can see a Bridge window view where | had selected the Stacks =
Auto-Stack Panorama/HDR command and the HDR candidate photos were automatically
grouped into stacks.

LX) " HDRs - Adobe Bridge

letadata  Keywords v | v Bridge Search: Curcent...

Figure 32 This shows the same folder after | applied Tools = Photoshop = Process
Collections in Photoshop. This generated three HDR files and saved them as PSD files.
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Bridge panels

Let’s now take a look at some of the individual panels in Bridge and
their uses.

Folders panel

The Folders panel (Figure 33) displays an expandable tree view list of
the folder contents for all drives that are currently connected to the
computer. When you highlight a folder in the Folders panel, all the
files in that folder are displayed as thumbnails in the Content panel
area on the right. You can drag and drop folders with ease within the
Content panel area and Folders panel areas, as well as drag directly to
external folders. While this is happening, Bridge writes a folder cache
of all the image thumbnails and previews, which it stores in a central
folder location; although, as was pointed out on pages 17-18, you
can configure the Bridge preferences so that the cache information is
exported locally as well. This saved cache should make the thumbnails
appear quicker the next time you visit a particular image folder. You
can also use the file path name for folder navigation. If you mouse
down on an arrow icon (circled), this calls up a menu list for all the
other folders available at the same root level (see Figure 34).

Stop Folder Cruising
Show Items from Subfolders

Tobago underwater
[ Tobago UW highres
[ Tobago general

Figure 34 The File path menu.

Favorites panel

The Favorites panel (Figure 35) can be used to quickly access locations
such as the Desktop or Pictures folder. The items that appear in the
Favorites panel are determined by the Bridge General preferences

(see page 3), but you can also add your own favorites by dragging
folders from the Content panel across to the Favorites panel list.
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Figure 33 The Folders panel.

Figure 35 The Favorites panel.
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Preview panel

The Preview panel (Figure 36) displays large previews of the selected
files and can be adjusted to be as large as you like. When more than one
image is selected in the Content panel the Preview panel will display

all the images at once up to a maximum of nine images. If you need

to inspect any more than this, you may be better off using the Review
mode (see the following page).

Click anywhere in the Preview panel and this will pop open a loupe
magnifying glass adjacent to the point where you clicked. This displays
that section of the preview image at a 1:1, actual pixels view inside the
loupe (but see the sidebar on [Mac], [PC] key behavior). You
can then use the EBED keys to zoom in (up to 800%) or zoom out
again, or use finger gestures on a mouse or trackpad for a fluid zoom.
To close, click inside the loupe. To reposition it, simply click anywhere
outside the loupe and/or click and drag inside the loupe. You can have
an active loupe on each image in the Preview panel: just click to add a
new loupe, and if you want to synchronize the loupe position so that
you can compare close-up details in two or more images at once, hold
down the (Mac), (PC) key as you drag the loupe.

Preview

e
Louisiana-02-Edit.psd

Figure 36 The Preview panel, showing a loupe close-up view of an image.
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Rotating loupe

When you work with the Loupe tool and
drag it to the corner of a preview image you
may sometimes see the loupe spin round to
reveal the corner details of the image. This
is normal, intended behavior.

€3/EZ) key behavior

As was pointed out earlier, if you go to
the Bridge General preferences, there

is an option you can select where a
(Mac), (PC)-click is required to
initiate opening the loupe (instead of just
clicking). This preference has no effect on
using the (Mac), (PC) key to
synchronize the loupe scrolling though.
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Review mode

Instead of relying on the Preview panel, you can use the Review mode
(Figure 37) to inspect large numbers of images at once. The Review
Mode can be accessed from the View menu (E3ED [Mac), BDED
[PC]) and presents the selected photos in a carousel type display. You
can cycle through the selected photos using the arrow keys in the
bottom corners, remove photos from a selection with the downward
pointing arrow, open a loupe view on the foreground image and create
new collections. Overall, I would say that the one-click preview feature
is better suited for the speedy previewing of multiple images.

Open loupe
Cycle through images Create new Collection ~ Remove image from review Cycle through images

Figure 37 The Review mode.
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Playback preferences

The Bridge Playback preferences (Figure 38) can be used to manage the
Playback settings. Let’s start with the Stacks section. If you refer back to
Figure 29 you will notice a Play button next to the file count. Clicking
on the Play button plays a slideshow of the thumbnails within the stack
at a speed determined by the Stack Playback Frame Rate per Second
menu. This can be useful where you have say, a sequence of timelapse
photos you need to review quickly.

The Audio options are more relevant for sound editors, while the
Video options are more relevant as you can choose to have video files
launch into play mode when selected and/or play in a loop.

Figure 38 The Bridge Playback preferences.
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Managing images in Bridge

As the number of photographs stored on your computer system
continues to grow you’ll soon end up becoming frustrated as you
struggle to find particular photos. This situation is only going to get
worse unless you choose to change the way you import and manage
your photographs. The metadata tools in Bridge are designed to help
you get started with the task of cataloging your image files. These will
allow you to add basic metadata and keyword information, which in
turn can help you categorize the photos in your image library. Once
you get into a regular habit of doing this you'll soon appreciate the
benefit this can bring when conducting a filtered image search.

Let’s first consider how metadata information is used to manage
other types of files on a computer. For example, if you download
a music album to iTunes, the individual MP3 files will contain the
album title, artist, track listings and genre of music. This is a good
example of metadata in action, because iTunes lets you make use of the
music metadata information to help manage your music collections
more easily. The iTunes cataloging is effortless because it all takes
place in the background and is done automatically. The big difference
between cataloging music files and image files is that when managing
a collection of images you mostly have to manually input all the
metadata yourself and that can require additional effort on your part.

Although Bridge has the potential to be used as an image asset
manager, it still lacks the sophistication of other fully dedicated asset
management programs such as Lightroom. To be honest, I mainly
use Bridge for specific file browsing tasks (such as when working on
a book project like this). Otherwise, I find that for most image asset
management and workflow tasks, Lightroom is the better program
to use for this kind of work. This is because Lightroom allows me to
import camera files exactly the way I want and has a better and more
versatile library management interface for editing and managing the
metadata. If you are serious about image library management and
cataloging your images, you may want to try out Lightroom.

This PDF is provided free with the Adobe Photoshop for Photographers book. Not for distribution or resale.

Adobe Photoshop Lightroom

A lot of people have been asking: if | have
Photoshop and Bridge, why do | need
Lightroom? I point out that Lightroom

is a workflow program that allows you

to manage your images all the way from
import through to the output stage. For
some people, the combination of Bridge
and Camera Raw provides them with all the
tools that they need to manage their pictures
and work in Photoshop. For amateurs and
professionals who are looking for a faster
and more streamlined approach for their
image processing and image management,
Lightroom will be the answer. | do still

use Bridge for a lot of file browsing tasks,
but | find that | now mostly prefer to use
Lightroom since it integrates smoothly with
Photoshop and offers some rather nice and
unique approaches to image processing and
image management that you won't find in
any other program.
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Star ratings

Star ratings can be used to sort out those that you like best from

the rejects and arranging them into groups. The Label menu Rating
section (Figure 39) can be used to apply star ratings to your files. This
system lets you apply cumulative ratings to the images you like and it is
therefore useful to familiarize yourself with the keyboard shortcuts that
can be used to apply ratings. These range from EJ(@ (Mac), CDED
(PC) to (Mac), (PC) (to apply 0-5 stars), but you can
also use EJE (Mac), @IED (PC) to increase the rating by one star,
or EIED (Mac), (PC) to decrease the star rating. The above
shortcuts can make it easier for you to focus your attention on the
images as you use the arrow keys to progress from one photo to
the next. In addition, you can still use the (Mac), (PC)
keyboard shortcut as a simple binary rating system that allows you to
add or remove a single star rating to a file. How you apply the ratings

is up to you, but generally speaking it is a good idea to be sparing with
the higher star number ratings. Unrated images can be the rejects,
while one and two stars can be used to mark the images you like best.
And three stars upwards should be reserved for those pictures that are
really special and so on.

Color labels

The Color Label preferences are shown in Figure 40. Color labels can
be used to signify different things. Author Peter Krogh suggests in
his DAM book that labels be used to apply negative ratings, where

a zero star represents an image that has been inspected but is rated

Figure 40 The Bridge Labels preferences.
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Stacks IE@I Tools Window Help

Rating
No Rating 30
Reject X &
Yok 82
Jokk 383
Jokdok 84
Yok kdok 385

Decrease Rating 88,
Increase Rating 8.

Label

No Label

B Select %6
| Second 87
[l Approved 38
[ Review #89
[0 ToDo

Figure 39 Image ratings and labels can
be applied via the Label menu in Bridge, or
by using the keyboard shortcuts described
in the main text. You can also mark an
image as being a reject. This is not the
same as deleting though; you are simply
labeling it as a potential delete image.
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neutral, a red label means it’s yet to be rated, a yellow label means it’s
an out-take and a green label means ‘trash me’ Meanwhile, a wedding
photographer might use color labels to quickly separate out shots
according to the location they were shot in. It is a simple matter of
selecting the individual or multiple images you would like to label and
then choosing a color from the list in the Label menu. Or, you can
use the keyboard shortcuts that range from EJ(D (Mac), EZDED
(PC) for red, to EPED (Mac), EZDED (PC) for blue. The labeling
controls have a toggle action. For example, if you select an image and
use EPE (Mac), EDE (PC) to label it red, you can use the same
keyboard shortcut to cancel the label color. You can also turn off the
labeling by selecting No Label from the Label menu. Note there is no
room for a keyboard shortcut for the Purple label. You can however,
use a right mouse-click to apply label colors via the context menu.

Color label descriptions

If you go to the Labels preferences in Bridge you can edit the text
descriptions given to each label color. You can rename these anything
you like, although this can potentially cause confusion where other
programs (such as Lightroom) may use different text descriptions for
the color labels.

One of the problems with Bridge and Lightroom is that the default
color label sets in both programs don’t match as they use different
default naming schemes. This means that where the default color labels
have been applied to files in Lightroom and saved to the metadata, they
will appear in Bridge with white labels. The Filter panel however, will
be able to read the color label text description and differentiate between
files labeled with the Bridge color label scheme and those labeled using
the Lightroom color label scheme.

Universal rating methods

You are not limited to just using the rating controls within Bridge. The
rating keyboard shortcuts described here work equally well when you
are reviewing your images in the Camera Raw dialog or the Slideshow
and Review viewing modes. However, in the Slideshow and Review
modes you only need to enter number keystrokes to add ratings or
labels, where you can use 0-5 to apply a star rating and use 6-9 to
apply a red, yellow, green or blue color label.
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File Type Associations

The Bridge File Type Associations preferences (Figure 41) list the
default programs to use when opening specific files. Most of the time
you can leave these as they are, but there are times when you may
want to force certain types of files to open in a specific program. For
example, some people may still use the EPS file format to save press-
ready files. Bridge normally opens these using Adobe Illustrator,
therefore you may in this instance want to change the File Association
setting to say, Adobe Photoshop 2020.

Figure 41 The Bridge File Type Associations preferences.
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Sorting images in Bridge

You can change the order in which the images are displayed in the
Content panel by going to the Sort menu shown in Figure 42. If

you mouse down on the menu here you can choose from a range of
different types of sort criteria and if you click on the arrow button next
to this menu list (circled in Figure 42), you can choose whether you
want to see the images displayed in an ascending or descending order.
Normally the sort order is set to the ‘By Filename’ setting by default.
However, if you were to select the ‘By Date modified’ option (and in
ascending order) those files that have been edited most recently will
appear first in the Content panel area.

Remember, you can manually drag the thumbnails to rearrange
their position in the Content panel. Just be aware that if you do this,
the Sort option will then default to ‘Sort Manually’ and you may have
to revisit the Sort menu in order to restore the previously applied sort
order rule (note that you can also access the Sort options by going
to the View menu in Bridge). As you start looking at the different
methods that can be used for filtering the images displayed in the
Bridge Content panel, you will see how combining the filtering with
the Sort options is useful for determining which files are made visible
in the content area and how they are arranged.

Output Metadata Keywords | v

‘ & 4y TBv ‘ Sort by Filename "1 -: >| wvim I

By Type

By Date Created
By Date Modified
By Size

By Dimensions
By Resolution

By Color Profile
By Label

By Rating

By Keywords

‘ Q v Bridge Search: Current... |

Manually

Figure 42 The Bridge window Sort menu options allow you to arrange the displayed
files by ascending or descending order (by clicking on the button circled here). You can
use any of the criteria listed in the Sort menu to rearrange the Content panel display.
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Refreshing the view

If you alter the contents of a volume or a

folder at the System level, outside Bridge,
then the Bridge Folder panel and Content
panel area won't always know to update the

revised volume or folder contents. If you

ever need to refresh the view in Bridge, you
can choose View = Refresh, or use the

keyboard shortcut.
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Filter panel

The Filter panel lets you view all the available metadata criteria
associated with the files in the current Bridge window Content panel
view. You can then choose single or cumulative criteria for filtering the
files that appear in the Content panel area. The Filter panel options are
grouped into sections and as soon as you click on any item listed in the
Filter panel, the contents of the Content panel are filtered accordingly.

When managing large folders or hierarchies of folders, these
filtering controls can make it easier to narrow down an image search.
For example, in Figure 43, you can see how Bridge was pointed at a
folder where the image files in that folder were labeled using red and
yellow labels and the ratings ranged from no rating to three stars. You
could filter files based on the color label, star rating or any of the other
available criteria. For example, in the Labels section I could click on
one or more color labels listed there and make a filtered selection that
was based on a combination of colored filters. You can also use the
keyboard shortcuts shown in the sidebar to filter files by label or by
rating. In the Filter panel you can filter files by other criteria such as:
by keywords, by file type, date created/modified, image orientation,
speed ISO rating, camera serial number or copyright notice.

Flattened view

To see a flattened view of all the photos in the current folder and
subfolders, go to the View menu and select ‘Show Items from
Subfolders. You can then apply a filter to the parent and all the
subfolders within. The only downside is that Bridge temporarily loses
track of the master folder in the Folders panel, but this can easily be
restored by deselecting ‘Show Items from Subfolders’ in the View
menu. There is also a ‘keep filter when browsing’ pin marker button

in the Filters panel (circled in Figure 43). If you click this, it preserves
and locks the filter criteria as you continue browsing. Just click again to
cancel and clear the filter completely.
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Filtering shortcuts

The following shortcuts can be used to filter
images in the Content panel:

show 1 or more stars
show 2 or more stars
show 3 or more stars
show 4 or more stars
show 5 or more stars
EIEDE EDEIE red labels only
yellow labels only
EDEDED EDEIED green labels only
EIEDE) EDEIED blue labels only
Show all items

Figure 43 The Filters panel.
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Metadata panel

The Metadata panel information is divided into sections (Figure 44).
The File Properties section lists the main file statistics such as file name
and size, etc., while the IPTC sections contain the file-specific metadata
information. To edit these and add new data, click in the field next to
the metadata heading and type in whatever you wish to include here
(the pencil icons indicate which metadata items can be edited). When
you are done, click the Tick button at the bottom, or hit (FZ29. How the
remaining sections appear listed depends on how the Bridge Metadata
preferences have been configured (Figure 45). Each metadata item

has a checkbox against it, allowing you to show or hide individual
items. Since it is unlikely that you will really want to see or use all the
metadata items listed here, you can deselect the items you don’t need.
If the Hide Empty Fields box is checked, the checked items will only be
displayed in the Metadata panel if there is an accompanying data entry.
Some of the items you see listed here are specific to other CC suite
programs, or specialist users. Basically, you can use the Bridge Metadata
preferences to determine which items you want to see displayed in the
Metadata panel.
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Figure 45 The Bridge Metadata preferences.
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Figure 44 The Metadata panel displays
the metadata information contained in

a file. The metadata sections can be
compacted to make viewing easier and the
IPTC fields shown here can all be edited.
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Image metadata

Maybe you are wondering what all the information in the Metadata
panel is useful for. Well, quite a lot actually, especially if you are
running a photography business, or are an amateur who shoots lots
of digital photographs. Metadata is often defined as being ‘data about
data’ and the concept of metadata is one you should already be quite
familiar with. For example, Librarians use metadata to classify and
catalog books in a library. With photographs it is possible to store lots
of information within individual files and use this to carry out more
sophisticated searches and cross-reference files.

File Info metadata

The File Info dialog (Figure 46) can be used to inspect the file metadata
for any document. With regard to image documents this means you
can use the File Info dialog to read all the EXIF data as well as edit the
IPTC image metadata that relates to the picture content. Photoshop has
always supported the information standard developed by International
Press Telecommunications Council (IPTC), which was designed to
help classify and label images and text files using metadata.

The File Info dialog can be accessed via the File menu in Photoshop

or the File menu in Bridge (EE3@ [Mac], GZ)ED [PC]). The File
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Powered by XMP

In 2001, Adobe announced XMP (eXtensible
Metadata Platform), which to quote Adobe:
‘established a common metadata framework
to standardize the creation, processing and
interchange of document metadata across
publishing work flows’. Adobe has already
integrated the XMP framework into Acrobat,
InDesign, Illustrator and Photoshop. XMP
is based on XML (eXtensible Markup
Language), which is the basic universal
format for using metadata and structuring
information on the Web. Adobe has also
made XMP available as an open-source
license, so it can be integrated into any
other systems or applications. Due to
Adobe’s enormous influence in this arena

it means that XMP has now become a
common standard in the publishing and
imaging industry. Adobe and also third-
party companies are now able to exploit the
potential of XMP to aid file management

on a general level as well as specific needs
such as scientific and forensic work.

Figure 46 This shows the File Info
dialog, which can be accessed via the File
menu in Photoshop or Bridge. It shows
editable metadata items such as the image
description and copyright notice. | have
circled here the Template menu discussed
in Figure 45.
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Info dialog contains 11 sections, some of which are user-editable,
such as the Basic section shown in Figure 46, while other sections,
like the Camera Data section, provide readable information only. You
can use File Info with single or multiple image selections to edit the
IPTC metadata: add your name as the author, mark images as being
copyrighted, add a copyright notice, etc. Also, marking an image

as being copyrighted has the extra advantage of adding a copyright
symbol to the title bar of your image window whenever anyone opens
it in Photoshop.

After adding File Info dialog entries you can save these as a custom
metadata template. For example, you can select an image, enter some
basic custom metadata such as the author name, copyright tag, etc.
Follow this by going to the Template menu shown in Figure 47 and
chose Export. For example, you could export the settings as a new
template to the Metadata templates folder (Figure 48). Similarly, you
can select Import from the Template menu if you wish to load an
existing template and edit it.

You can also go to the Tools menu in Bridge and choose Create
Metadata Template. This opens the dialog shown in Figure 50, where
any of the custom metadata already applied to the photo will appear
in the template fields ready for you to edit. When you create a new
template it is best to enter the exact information that should be saved
and nothing else. I suggest you don’t add any keywords or captions,
unless these need to be included in the saved template.

Export Template

Save As: London studio work v
Tags:
Where: Metadata Templates | <)

File Format: XMP Files (*.xmp) &

Cancel

Figure 48 The File Info Template menu.

Appending and replacing metadata

Once you have created and saved a custom metadata template, you

can select other images and apply the metadata template via the Bridge
Tools menu where you can choose between Append Metadata or
Replace Metadata (see Figure 49). Replace Metadata substitutes all pre-
existing metadata with that in the template. Append Metadata is the

safer option since it only adds to the metadata that is already embedded

in the image file.
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Import...
Export...
Demo images
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Figure 47 The File Info Template menu.

A+ Gl Window Help
Batch Rename... TXR

Create Metadata Template...
Edit Metadata Template >

Append Metadata »> Demo images
Replace Metadata ®  Demoimages 2

Ivy Todd Std IPTC
Secho ® " Untitled
Photoshop >

Figure 49 The Bridge Tools menu.
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Controlled Vocabulary

Figure 50 To open the dialog shown here, go to the Tools menu in Bridge and choose
‘Create Metadata template’. This shows an example of how you might fill in some of the David Riecks runs a website with tips and
IPTC Extension metadata sections. You can also obtain more specific information via the quidelines on how to work with a controlled
www.newscodes.org website. vocabulary at:
www.Controlledvocabulary.com.
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IPTC Extensions

Bridge uses the IPTC Extension Schema for XMP, which is a
supplemental schema to the IPTC Core. It provides additional fields
with which to input metadata that can be useful to a commercial
photography business. In Figure 51 I have provided examples of how
you might complete some of the items listed in the IPTC Extensions
section of the Create Metadata Template, and you will see brief
explanations of how each of these new fields may be utilized. Also, in
Figure 50 you can see an example of how the IPTC Extensions data is
presented in the File Info dialog. Basically, the IPTC Extensions schema
can provide additional information about the content of the image
such as the name, organization or event featured in a photograph. It
provides you with further fields that are useful for administration work,
where you can apply globally unique identifiers (known as GUID).
It offers fields for precisely defining the licensing and copyrights of a
particular photograph. For example, rather than just saying ‘this photo
is copyright of so and so; it lets you specify the name of the copyright
holder as well as who to contact to obtain a license. This might well
be a picture library or a photo agent rather than the photographer
themselves. The image supplier can also be identified separately. Again,
it might be a photo library that supplies the image rather than the
photographer directly.

Photographers who photograph people can record specific model
information such as the age of the model and you can also provide
a summary of the model release status. The same thing applies to
photographs of private properties, where under some circumstances a
property release may be required.

Other types of metadata

Metadata comes in many forms. In the early days of digital camera
technology development, the camera manufacturers jointly came up
with the EXIF metadata scheme for cataloging camera information. The
EXIF metadata in your digital camera files will tell you things like what
lens setting was used, when a photo was taken and the serial number

of the camera. This could be useful if you were trying to prove which
camera was used to take a particular photograph when there were a

lot of other photographers nearby trying to grab the same shot and

also claiming authorship (such as when shooting among a gathering of
other photojournalists). The EXIF metadata can describe everything
about the camera’s settings, but the EXIF schema cannot be adapted

to describe anything but the camera data information. Even so, EXIF
metadata searches are useful where you may wish to isolate the photos
shot with a particular camera and lens combination or where you may
wish to filter all the photos that were shot using a particular ISO setting.
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Figure 51 This shows an expanded view

of the File Info IPTC Extensions section.
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GPS metadata

The File Info and Metadata panel can include GPS metadata, where
if GPS coordinates are embedded in a file, you can see the position
coordinates, altitude and direction the camera was pointing when the
photo was taken (Figure 52).

Currently it is quite tricky to marry up the GPS metadata from
a track log file recorded using a GPS device and get the time zones
and clock times to match. Even so, this is still useful information to
have available and many photographers are already in the habit of
geotagging their images. This data can prove really useful when it is
read by programs such as Google Earth or Lightroom (especially since
Lightroom features a dedicated Map module). However, while GPS
data is useful, you may sometimes want to be careful sharing this data
with other users. For example, you might not want GPS coordinates of
photos taken of your children to be embedded in photos you upload to
social media websites. This is why it is useful to manage your photos in
a program like Lightroom, where it is possible to restrict such metadata
at export.

@ IMG_2368.JPG
Basic Camera Location
| Camera Data Position: 49° 17' 24.43" N, 124° 39' 34.83" W
Odlpin Altitude: 152.63 m
IPTC e
Image Direction: 217.40° (True direction)
IPTC Extension
GFS\D&G | Subject Location
Audio Data e
Destination:
Video Data A
Bearing: 217.40° (True direction
Photoshop carig ( )
DICOM Distance:
Raw Data
Time Stamp (GMT): 21 Jul 2016, 19:41:09
Receiver Movement: 0.66 km/h at ° ()
Processing Method:
Map Datum:
Area Information:
Differential correction:
Powered By
- Xiap Template... ¥

Figure 52 The File Info GPS Data panel section.
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Other File Info sections

Other items have specific uses such as the DICOM metadata
section items which have been specifically designed for embedding
important medical data information in medical images.

The amount of metadata that can be recorded has now grown to
the point where the File Info... has become extremely crowded. The
most recent versions of Photoshop and Bridge have overcome this
with an improved layout design for presenting the File Info metadata
information.

Importance of metadata

It is quite scary to consider the number of freely distributed digital
images out there that contain no information about the contact

details of the person who created the image. If nothing else I suggest
you create a Metadata template that contains your current contact
details, marks your photographs as being copyrighted and apply this

to all your images. Right now the issue of what are referred as ‘orphan
works’ should be of real importance to photographers everywhere.
There are plenty of people and organizations who would dearly like to
see the copyright laws changed so that non-copyright marked images
are made free to use. This isn’t helped by the fact that certain social
media websites still strip the copyright metadata from files that are
uploaded to their sites. There is nothing that can be done to stop people
deliberately removing copyright notices from images and turning them
into orphan works (although doing so is still a breach of copyright law),
but the more you do to protect your images now, the more chances you
will have later of enforcing your rights.

Edit History log

If the History Log options are enabled in the Bridge History Log
preferences (Figure 53), an edit history can be recorded in either the
file metadata, as a separate text file log, or both. The Edit log items can
be recorded as session information only (such as the time a file was
opened and closed), concise or as a verbose record of what was done
to a file in Photoshop. If you choose to embed the history log in the file
metadata, the Edit History log can be viewed via the Bridge Metadata
panel (see Figure 54). The edit history has many potential uses. It can
be used to record how much time was spent working on a photograph
and could be used to calculate how much to bill a client. In the world of
forensics, the history log can also be used to verify how much (or how
little) work was done to manipulate an image in Photoshop.
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Figure 53 The Photoshop History Log preferences.

The same arguments could apply if validating images used to
present scientific evidence. In the case of images that have been
processed via Camera Raw, the Camera Raw metadata section also
stores a record of the Camera Raw (or Lightroom) settings used.

Hidden metadata

Bear in mind there may also be hidden metadata that won't show up
in any of the Metadata panel sections. This could be things like camera
manufacturer EXTF metadata that contains proprietary information
that only the camera manufacturer’s software has access to.

Figure 54 The Bridge Metadata panel
Edit History log.
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Keywording

You can group and organize images within Photoshop using keywords.
By using keyword tags to describe the image content, you can catalog
your files more comprehensively.

It is usually best to add keywords at the same time as you import
new images. For example, Figure 55 shows the Basic section of
the File Info dialog where you can add keywords to an image. It is
important to note that each keyword must be separated by a semi
colon or a comma. This is important as it ensures the keywords are
clearly separated. Such keyword metadata can also be included when
you create a metadata template. For example, every time you shoot
a particular sporting event you might want to have a template that
applies relevant keyword metadata you always need for these types of
assignments, such as the name of the stadium location and home team.
You will also need to know the exact keyword phrases to type if they
are to match the keyword data used elsewhere for other images. This is
why it is sometimes better to use the Keywords panel to do this.

[ ) _1BA1455.CR2
[Basic Document Title:
Camera Data Author:  Martin Evening
Origin @ Semicolons or commas can be used to separate
multiple values
IPTC
IPTC Extension Author Title:  Photographer
GPS Data Description:
Audio Data
Video Data
Photoshop Rating: W W T 77 ¢
DICOM Description Writer:
Raw Data Keywords: | Dornie; Eliean Donnan Castle; Kyle Of Lochalsh;
Places; Scotland; UK
@ Semicolons or commas can be used to separate
multiple values
Copyright Status:  Copyrighted S
Copyright Notice: = © Martin Evening
Powered By
XIIIp Template... ¥ ( Cancel ) ( OK )

Figure 55 The File Info Basic section.
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Keywords panel

The Keyword panel (Figure 56) displays all the keywords that are
associated with the images you have currently selected. The Keywords
panel provides a basic level of organization as it allows you to arrange
keywords that you come across into a hierarchy list, plus you can

also use the Keywords panel to add new keywords. Click on the ‘Add
new keyword’ button to create a keyword category, such as ‘People’ or
‘Places, type in the name and hit to add the keyword (or use
to cancel). You can then highlight the keyword and click on the ‘Add
new sub keyword’ button to add a new sub keyword. Once keywords
appear listed in the Keywords panel you can make a file selection
within Bridge, go to the Keyword panel and click on the empty square
to the left of the desired keyword to apply, or click again to remove.
This method allows you to assign one or more keywords to multiple
images at once. If the ‘Automatically Apply Parent Keywords option is
checked in the Bridge Keywords preferences (Figure 57), checking a sub
keyword automatically selects all the parent keywords too.

Figure 57 The Bridge Keywords preferences.
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Make Persistent

New Keyword
New Sub Keyword

Rename
Delete

Find...

Add new sub keyword
Search keywords ~ Add new keyword

Delete keyword

Figure 56 In this view of the Keywords
panel an image was selected and | can see
that six keywords were assigned, telling
me that this was a photograph taken on
The Isle of Skye in Scotland, UK and

that one of the keywords identified this

as being part of an HDR sequence. Now,
in this instance, ‘HDR' appears in italics,
which indicates this was not an established
keyword in the Keywords panel. To make
this keyword persistent, | used a @Z)-click
(Mac), or right mouse-click to open the
contextual menu shown here and chose
‘Make Persistent’.
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Making keywords permanent

The keyword information will accumulate as you select further images
and you will notice that some of the ‘visited image’ keywords appear in
italics. This indicates that they are only temporary. If you were to quit
Bridge and relaunch, these temporary keywords would be cleared from
the list. To make such keywords permanent you should use the context
menu (as described in Figure 54) to make them persistent.

Where keywords are stored

Like other metadata, keyword information (including the keyword
hierarchy) is stored directly in the file's XMP space, or in the case of
raw files, either to the Camera Raw database, or as an XMP sidecar file.
The Keywords panel displays the accumulated information that it has
read from various image files’ metadata and can also be used to write
keyword metadata back to the files.

Other keywords

As you enter keywords via the File Info panel, any keywords that are
unrecognized will appear listed under the category: ‘Other Keywords.
You can then use the Keywords panel to rearrange these into a suitable
hierarchy and have the option to make them persistent. You will also
find that where Bridge is unable to read the hierarchy of keywords that
have been entered via another program, these too may appear listed
under ‘Other keywords.
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Image searches

The Bridge window search field allows you to use either a standard
Bridge search or a system-based file search (such as Spotlight on the
Mac). All you have to do is select the folder you want to search in, enter
the phrase you want to search for and hit or GEME). This will
carry out an instant search that includes all subfolders. If that fails to
produce any results or you want to expand the search criteria, you can
click on the New Search button which opens the Find dialog shown
in Step 3. Here, you’'ll find more search options such as the ability to
combine different match criteria and match policies. If Bridge has

not had a chance to cache the files in all folders yet, you can select the
Include Non-Indexed files option. However, this will make for slower,
but more thorough searches.

The search criteria can be for almost anything you want. The source
folder will default to the folder you are viewing in the front-most
Bridge window, but you can select other folders to inspect as well and
if the folder you are searching contains a lot of subfolders, you’ll need
to make sure that the ‘Include All Subfolders’ option is checked. The
search criteria can also be adapted in various ways. For example you
can include search terms where you ask Bridge to search for files that
‘exclude’ specific criteria.

o + Bridge Search: Current Folder

lﬁﬂfnﬂ: Spotlight Search: Current Folder
Spotlight Search: Computer
Search Adobe Stock

Advanced Search...

1 This shows a Bridge window view where | was about to carry out a file search of a
master Casting Photos folder, looking for any images that matched the term ‘Jasmin’.
You'll note that there are three search options available. In this instance | chose to use
a Bridge search, which would carry out a search by file name and keywords using the
Bridge search engine.
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Skipping the Bridge search field

You can skip the Bridge search field
completely and open the Find dialog shown
in Step 3 directly. Just go to the Edit menu
and choose Find..., or use the
(Mac), (PC) keyboard shortcut.

2 The standard Bridge result gave no results, so I clicked on the ‘New Search’ button.

3 This opened the Find dialog, which allowed me to expand the search criteria used.
Here, | changed the ‘File Name’ criteria to ‘All Metadata’ (note, you'll have to retype the
search phrase again when you do this) and clicked ‘Find’.

4 This time | was more successful, because Bridge now included all metadata search
criteria such as the Caption IPTC metadata that had been added to the files and the
results of the search were now displayed in the Content panel area.
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Collections panel

The ability to create collections is an important feature in any image
management program. Collections help you quickly access specific
groups of images. The Bridge Collections panel is shown in Figure 58.
To create a new collection, all you have to do is make a selection of
images in Bridge and then click on the ‘Add New Collection’ button in
the Collections panel. Or, you can click on the ‘Add New Collection’
button to create a new collection first and then drag files from the
Content panel to the collection. You see, with collections you are not
limited to refining the files in single folder; you can add images to any
number of different folders to create a new collection. In Figure 58 I
highlighted the ‘South West USA’ collection. This collection contained
a selection of the best images I had shot on a trip around south western
States in the USA.

To remove photos from a collection, you need to make a selection
of the photos and then click on the Remove From Collection button
(Figure 59). To delete a collection, select a collection in the Collections
panel and click the Delete collection button at the bottom of the panel.

Add new collection
Editsmart  Add smart collection
collection Delete collection

Figure 58 The Collections panel showing
both normal and smart collections.

Figure 59 To remove a file (or files) from a collection, click on the ‘Remove from
Collection’ button (circled).
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Smart Collections

As well as creating normal collections, you can click on the Add New Smart Collection rules

Smart collection button to open the Edit Smart Collection dialog shown 11,6 riteria section can be used to add one
in Figure 60, where you can choose the source folder group to look in, or more file selection criteria and each item
followed by the various criteria to filter by. In this example, I filtered can have conditional rules. For example,
the files in the ‘Personal Photos’ folder to create a smart collection that when you select ‘Document Type’, you can
contained only the images that had a two star rating or higher. choose to filter according to whether files

equal or don’t equal this criteria. When the
Rating option is selected you can choose
to filter according to whether files have the
exact same rating, or the same and greater,
etc. Next, comes the Match section. If you
select the ‘If any criteria are met’ option, this
acts as an ‘OR’ sort function, where files are
sorted according to whether they meet any
one of the individual criteria. If the ‘If all
criteria are met’ option is selected, this acts
as an ‘AND’ sort function, where files are
sorted according to whether they meet all
the combined filter criteria.

Figure 60 This shows the Edit Smart Collection dialog and below, the resulting
collection this smart collection setting produced.
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Figure 61 The Output workspace showing the Output Settings panel.

The Output workspace

The Bridge Output Workspace is shown in Figure 61. This can be used
to create PDF outputs based on the different types of layouts available
from the Output Settings Template menu (see above).

Having selected a template to work with you just have to drag and
drop photos from the Filmstrip below to add to the template layout.
You can drag photos within the template layout to reorder, or select
a photo to remove and click the Remove button. As more photos are
added than can be accommodated within the layout, new pages will
be added.

The default behavior is for the Output workspace panels to open in
Solo mode (see the Output preferences in Figure 67). Figure 62 shows
a close-up view of the Output Settings and Document panels. You can
use the Document panel to set the document page size and resolution
and adjust the image quality when exporting as a PDE If you choose
to include the filename and file extension you can select the font, color
and font style below.
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Figure 62 The Output Settings and
Document panels.
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Figure 63 The Grids and Margins panel. ~ Figure 64 The Watermark panel.

The Grid and Margins panel (Figure 63) can be used to modify the
Grid Layout arrangement, Cell Spacing and Cell Size. If you refer to Figure 65 The Header and Footer panel.
Figure 67 you will notice a ‘Prefer Cell Size Over Cell Spacing While
Resizing Margins’ preference. When checked this means adjustments
to Margins settings below will result in the Cell Spacing staying locked
as the Cell Size is resized.

Figure 64 shows the Watermark panel. The settings here can be
edited to add either a text or an image watermark based on a selected
image file. You can also choose the placement where the watermark
will appear on each individual image.

The Header and Footer panel is shown in Figure 65. Here you can
choose to add Header and Footer information and adjust the fonts
and header/footer margins. When you have finished editing the panel
settings you can click on the + button (circled in Figure 61) to add as a
new custom template.

The PDF Properties panel (Figure 66) can be used to add security
measures such as to require a password to open the document. In the
Playback section you can choose to have the PDF play as a slideshow.
Finally, you'll need to click in the Export to PDF button to create a PDF
document. This can then be shared with others or used to make a print.

Figure 66 The PDF Properties panel.
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Output preferences

The Output preferences are shown below in Figure 67. By default, the
PDF documents can be viewed after completion of export.
If the ‘Preserve Embedded Color Profile’ option is selected this
preserves the color profile that is embedded in the image or images. If
this is not possible, the Adobe Output Module will convert the output
document profile to sSRGB.
The default behavior is for the Output workspace panels to open in
Solo mode, where as you click to open one panel, the others auto-close.
As mentioned on the previous page, if the ‘Prefer Cell Size
Over Cell Spacing While Resizing Margins’ preference is checked,
adjustments to the Margins settings will result in the Cell Spacing
staying locked as the Cell Size is resized. If the images you are including
for output include transparent areas, check Preserve Transparency for
Images’ to preserve the transparency.

Figure 67 The Adobe Bridge Output preferences.
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Contact Sheet Il

The Contact Sheet II feature is available in Photoshop via the File =
Automate menu and also in Bridge via the Tools = Photoshop menu.
The Contact Sheet IT dialog (Figure 68) can be configured to process all
the images selected in the Source section and generate custom contact
sheets in Photoshop. Figure 68 shows the settings used to generate the
accompanying contact sheet shown below. However, with the inclusion
of the Output Workspace to Bridge it may be possible people will want
to use that method instead.

Figure 68 The Contact Sheet Il dialog.
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Behance export

This is not a Bridge feature, but something that’s available in
Photoshop: the ability to export photos for public sharing via Behance.

Behance

1 To upload an image | was working on to Behance, | chose File => Share on Behance. ..
As I had already created a Behance account, this opened the Behance Home page, where
I clicked on the Create a Project button (circled).

PEe < # behance.net = o 0

Bohance : Croata Project o

Béhance Fo i ve Jobs | Createa Project

1. Content

Need help? Visit our FAQ —
+ T <> n

Files Text Embed Lightroom Phaota Grid
Photas

2 In this step | clicked on the Lightroom Photos button to select this as the source.
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3 L & lightroom.adabe.com

Import Selected

3 This took me to my Lightroom Photos account page, where | selected a photo to import.

. <UD 8 boranconot nl o

Behance :: Create Project [

Behance Create a Project

1.Content | 2, Cover | 3. Settings Preview @

Need help? Visit our FAQ —

4 The imported photo then appeared added to the Behance new project page.
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h| @

@ behance.net <

Behance :: Create Project

Project Cover Image

COVER PREVIEW

[= bay, Vancouver
Island, BC

F"808x632px’ = a

GIF files will not animate.

+

Cancel Crop & Continue

5 | clicked the Continue button (see Step 4) and chose how the preview crop would look
and clicked the Crop Cover & Publish button to complete the upload to Behance.

About the Behance Network

Behance Network can be accessed at: www.behance.net. This is
basically a networking site for creatives to share their work. Having
Behance integration incorporated into the latest version of Photoshop
in this way, makes it very easy to click and upload from any image you
happen to have open in Photoshop. If you are not already a member,
you will be required to register the first time you try to use the service.
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Figure 69 The Publish panel. When you click on either the Adobe Stock Contributor or
Adobe Portfolio buttons, this creates a drag area for you to drag files to upload.

Publish panel

The Publish panel (Figure 69) allows Adobe Stock contributors to
upload files to Adobe Stock. Or you can use the Publish panel to
publish your assets on Adobe Portfolio. To view the Publish panel in
any workspace in Bridge, choose Window = Publish Panel.

Adobe Portfolio

To publish to Adobe Portfolio, go to the Publish panel click to select
the Adobe Portfolio publish service. A drag area appears in the Publish
panel. From the Content panel, select an asset or a selection of assets
that you want to upload to Adobe Portfolio and drag the selection onto
the drag area in the Publish panel.

Essentially, Adobe Portfolio comes free with your Creative Cloud
subscription and lets you quickly and easily build a website to showcase
your photos. Whenever you upload photos to Adobe Portfolio, you can
also choose to share them on Behance, which is where viewers to the
Behance site can discover and interact with them.

Adobe Stock

If you are already registered as an Adobe Stock contributor you can
start using the Publish panel straight away to upload image assets
via the drag area (see Figure 70). Otherwise, you’ll need to setup a
contributor account first.
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Bridge automation

The Photoshop Automate features can all be accessed directly in
Bridge by going to the Tools menu and selecting an option from the
Photoshop submenu (Figure 71). For example, to apply a Photoshop
batch action process, make a selection of images in Bridge and choose
Tools = Photoshop = Batch... You can then configure the Batch
dialog to apply an action routine to the selected photos. The Image
Processor can be used to batch process images in Photoshop where you
typically want to output, say, a set of JPEG versions of an image at a set
pixel size and compression setting, or convert to more than one size,
color space, or format. You can also use the Tools = Photoshop menu
to carry out a Merge to HDR Pro or Photomerge directly from Bridge.
When creating panorama Photomerges, the thing to watch out for
here is the size of your source images. If you are working from raw
originals in Bridge, you may want to open these via the Camera Raw
dialog first, go to the workflow settings, set the pixel output size to
something lower than the full image size and click on the ‘Done’ button
to apply this setting to the selected images. Then, when you choose
Photomerge, Bridge opens all these files at the new size setting you
had just set in Camera Raw. Alternatively, you might like to consider
choosing Tools = Photoshop = Load Files Into Photoshop Layers...
This allows you to open all the selected images as layers in a single
Photoshop image first. You can then use Image = Image Size to reduce
the pixel dimensions before choosing File = Automate = Photomerge.

Label Window Help

Create Metadata Template...

Edit Metadata Template >
Append Metadata >
Replace Metadata >
Cache >
Photoshop > Batch...

Contact Sheet Il...

Image Processor...

Lens Correction...

Load Files into Photoshop Layers...
Merge to HDR Pro...

Process Collections in Photoshop

Figure 71 The Photoshop Automate menu is available from the Tools menu in Bridge.
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Renaming images

To rename an image in Bridge, just click on the file name to activate

it and type in a new one. To batch rename a selection of images,

choose Batch Rename. .. from the Tools menu (EPELDED [Mac],
EZEZIDED [PC)), which opens the dialog shown in Figure 72. Here,
you can rename the files in the same folder or rename and move or
copy to a new (specified) folder. In the New Filenames section you can
configure the file renaming structure by clicking on the plus buttons to
add new components to the file renaming structure. When you mouse
down on a renaming component there will often be further options that
you can choose from. In the Figure 72 example I included a YYMMDD
Date Time file renaming option at the beginning, based on the date the
file was created. Bridge also allows what's called ‘string substitution. This
simply means that you can use the Batch Rename dialog to search and
replace specified phrases in an existing filename structure. Suppose all
your files start with °_MG’ You can use the String Substitution to replace
this phrase with alternative text. In Figure 72 you can see I had ‘String
Substitution’ selected as a file naming option. I was able to replace the
above prefix with custom text that related to the shoot (such as ‘casting )
and preserve the four number sequence that followed afterwards in the
original filename.

Editing the Batch renaming fields

Once you start editing the pop-up menus,
you will discover that the renaming options
are quite extensive. You can select items
such as Text, where you can enter your
own text data. You can also incorporate the
original filename in parts of the new name.

Figure 72 The Batch rename dialog.
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Clicking on the Preview button opens a separate window
(Figure 73) that shows you exactly how all the selected photos will be
renamed. Clicking on the ‘Export to CSV’ button exports a comma
separated value file (CSV), which can then be opened via a spreadsheet
program (see Figure 74). This feature is designed to meet the needs of
users who want to maintain an exact record of everything that has been
done to a file.

Reizzkekizinist

:nm:t.gﬁlﬂ

Figure 74 This shows an example of an
exported CSV file opened in a spreadsheet
Figure 73 The Batch Rename Preview dialog. program.

Renaming schemes

The renaming scheme you use can be anything you want. There are no
hard and fast rules, but whatever method you decide to use it should

be done with a view to the future and should avoid the possibility of

you creating filenames that overlap with other files. I prefer to adopt a
naming scheme where a short text description (such as the client name
or an abbreviation) is followed by the date shot, using the YYMMDD
format, followed by a four digital serial number. You can also use the
Presets menu (circled in red in Figure 72) to save a renaming scheme as
a custom preset. Click on the Save... button, give the preset a name, click
OK and it will now be added as a new preset to the Preset menu list.
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Undoing a Batch Rename

In the Batch Rename Filename options (Figure 75) there is a ‘Preserved
Filename’ option to preserve the original filename. If for some reason
you slip up, you can use the Batch Rename dialog to locate and reassign
the original name to the file. However, this will only be possible if you
previously remembered to check the ‘Preserve current filename in
XMP Metadata’ box (circled in blue in Figure 72).

Text
New Extension
Current Filename
Preserved Filename
Sequence Number
Sequence Letter

+~ Date Time
Metadata
Folder Name

String Substitution

Figure 75 The Batch renaming New Filename options.

Applying Camera Raw settings

You can use the Edit = Develop Settings menu in Bridge to apply

a saved Camera Raw preset setting to selected images, or choose
Previous Conversion to apply the last used Camera Raw setting. The
settings listed here will be like the ones you see listed in the Camera
Raw Preset panel. You can also use this menu to copy and paste
settings from one file to another, or better still, use (Mac),
(PC) to copy a setting and (Mac),
(PC) to paste. The Edit = Develop Settings = Clear Settings command
can remove any applied develop settings and reapply the default
Camera Raw settings.
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